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Lesson O — Tutorial Setup

For this tutorial you must not use the GNOME User Interface. The program will not
open in that environment. You may use any of the other available window environments.

1. Inyour root directory, go to your ece551 directory (as should have been created in
the modelsim tutorial)

cd eceb51

o°
\%

2. Copy all files from ~ece551/public_html/tutorials/designvision to your current
directory

o
v

cp -r ~hickmann/public html/tutorials/designvision .

3. Change directory to your tutorial directory

o\
\%

cd designvision

4. Copy file from current directory to root directory

o\
\%

cp .synopsys_dc.setup ~/
5. Change to the main tutorial directory

%> cd dv_tutorial/risc design

It is important to start Design Vision from the directory where your project is so that
environment variables that are automatically setup will be made correctly.

IMPORTANT

If you see that the design variables do not match later on in the tutorial do the following:
*In the directory you started Design Vision in remove the .synopsys_dc.setup file.
%> rm .synopsys_dc.setup

This will force design vision to use the one from your root directory.

6. Start Design Vision. Make sure to use the newver command to run the latest
version on the Linux machines. The older version will only run on the Sun
machines.

%> newver design vision
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[E File | Edit View Select List Hierarchy Design Sghematic Attributes Timing Test Window Help =[8( x|

e ElEa S e 8 el Z s a

Logical Hierarchy || Cells (Hierarchical)
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source Ssynopsys_root/auxxSouifdv/dv_setup.tcl J
Initializing gul preferences fram file Jfpongfusrdsk/kirupnows.synopsys dv_prefs.tcl

design visien-t> gui_start

design vision-t> design_vision-t>

Laog IHistory IErrorsﬂMarnings ]

design_vision—t= |

| Selected: =1 v

Figure 0-1 : Design Vision Default Window

We may look at the main window of Design Vision to see a few of the program’s
features. In the top panel, there are two panes. The left pane is a full Hierarchy pane; it
will show the entire hierarchy of the current design (as selected from the drop-down box
in the upper control panel). The right panel is a context based panel which will display
contents based upon the selection in the drop down box at the top of the panel.

The bottom panel has three different tabs: log, history and errors/warnings. The
important thing to note about this panel is that every command you perform will appear
in this panel, allowing you to learn the commands and create scripts of commands for
future use. It is also the panel that you must monitor to determine the source of errors
and warnings, allowing you to fix the code or correctly determine if a warning is
expected.

Page 3 of 65



Lesson 1 — Code Input (Analyze and Elaborate)
1. Analyze RISCTYPES.VHD first

File->Analyze

Bl  AnalyzeDesigns =l

File names in analysis order:

Add. .

Bi=l[==

F

Automatic Ordering

Format: |ﬂ«um j
Wort librans: [WORK [

[~ Create new library if it does not exist

0] Cancel Apply |

4

Figure 1-1 : Analyze Design Dialog

Click Add
select source/RISCTYPES.VHD

- i

Look in: |_qfpungfusr4fk.f'kjrupnow.-’designvisiontuturialﬁsourcef
23 .

(7 aLu.vha

[ conTROL.vhd
[JoaTa_PaTH.vhd

[ INSTRN_LAT.vhd

] PRGRM_CNT vhd

] PRGRM_CNT_TOP vhd
[] PRGRM_DECODE.vhd
] PRGRM_FSh.vhd

[] REG_FILE vhd

RISCTYFES.vhd

[ RISC_COREvhd

[ sTACK_FSM.vhi
[ sTACK_MEM.vhd
[} sTACK_TOP.vhd

File name; ['RISCTVPES.vhd"
File type: | Database Files { *v *vhd *vhdl) = Cancel |

Figure 1-2 : Analyze Design Dialog

2
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Click OK

2. Now analyze the rest of the files
File->Analyze
Click Add..
Select All Files in /source Except RISCTYPES.VHD

Note that the reason we must analyze in a specific order is because of some of the
ordering requirements of VHDL, so no particular order will be required when using
Verilog code with Design Vision

L et -1[=][x]

Laak jn: | A /pongdusrdkikjrupnowidesignvisiontutaralisources’

File name: |’hd" "STACK_FSM.vhd" "STACK_MEM.vhd" "STACK_TOP vhd"

j Cancel |

File type: | Datahase Files { ".v “.vhd ".vhdl)

24

Figure 1-3 : Analyze Design Dialog (2)

| " =||=]|x|

File names in analysis arder:

iontut... [

A,

ntut...

ntut... [elete |
ntut...

ntut... - |
ntut...

ntut... — |
ntut...

niut... Automatic Qrderingl

Eormat: | ¥HDL (vhal) R

Work library: [WORK, |

[~ Create new library if it does not exist
[o]8 | Cancel | Apply |
)

Figure 1-4 : Analyze Designs Dialog
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Analyze is similar to compilation. It will check the syntax of each of the files to verify
correct use of the language and that all code used is synthesizable.

Initializing gui preferences from file /pong/usrd/k/kjrupnow/. synopsys_dv_prefs. tcl ;I
design vision-t> gui_start

design wision-t> design_wvision-t> analyze -library WORK -format whdl {{/pong/usrd/k/kjrupnow/designvisiontutorial/source /RISCTYPES. vhd}}
Loading db file */usr/apps/edassynopsys/syn_U-2003. 06/ libraries/syn/standard. s1db”

Loading db file */usc/apps/eda/synopsys/syn U-2003. 06/libraries/syn/dw_foundation. sldb’

Loading db file */usr/apps/edassynopsys/syn_U-2003. 06/libraries/syn/gtech dh’

Loading db file */usc/apps/eda/flexstream. 3.3/lsi_fs_3. 3/1ib3p/synopsys/gf Lxp/gflxp_lsi_wc.db’

Loading db file */usr/apps/eda/flexstream 3. 3/1si fs_3. 3/1ib3p/synopsys/qf lxiofgflxio_1si we. db’

Reading in the Synopsys vhdl primitives

/pong/usrd /k/kjrupnow/designvisiontutorial /source /RISCTYPES. vhd:

design wision-t> analyze -library WORK -format vhdl {{/pong/usrd/k/kjrupnov/designwisiontutorial/source /STACK_TOP. vhd} {/pong/usrd/k/kjrupnowv/desigre
Spongsusrd Kk jrupnow/designvisiontutorial/source /STACK_TOP. vhd:

/pong/usrd k] rupnow/designvisiontutorial /source /STACK_MEM. whd:

Jpong/usrd k/kjrupnow/designvisiontutorial /source /STACK_FSH. vhd:

Spongsusrd Kk jrupnow/designvisiontutorial /source/RISC_CORE. whd:

Spong/usrd A/kjrupnov/designvisiontutorial /source /REG_FILE. vhd

Jpong/uscd k/kjrupnow/designvisiontutorial /source /PRGRM_FSM. vhd:

JSpong/uscd /k/kjrupnows/designvisiontutorial/source /PRGRM _DECODE. vhd

Spong/fusrd sk jrupnow/designvisiontutorial /source /PRGRN_CNT_TOP. whd:

Spongsusrd Kk jrupnow/designvisiontutorial/source /PRERM_CNT. whd:

/pong/usrd bk rupnow/designvisiontutorial /source SINSTEN_LAT. vhd

Jpong/uscd k/kjrupnow/designvisiontutorial /source /DATA_PATH. vhd:

#pongsusrd Kk jrupnov/designvisiontutorial /source /CONTROL. whd:

Spongusrd Sk rupnow/designvi siontutorial /source /ALY vhd:

Figure 1-5 : Analyze Results Log

3. Elaborate the design

File->Elaborate

Change Library to WORK

Change Design to RISC CORE (struct)
Click OK

L

Library:  [DEFAULT

Design: [RIsC_CORE(STRUCT)

Barameters:

SN RN i

Mame |Value

[T Gate clock [command set_clock_gating_style must have been executed)

[T BReanalyze out-of-date libraries

Ok I Cancel | Apply

Figure 1-6 : Elaborate Dialog

The elaboration step may take several minutes. This step is similar to loading the design
in Modelsim. The design is checked to make sure that the code is synthesizable, the sub-
designs connect correctly and that there are no major errors in the implied circuit. (At the
end of this step you may determine that latches were incorrectly implied and fix your
code to remove them).
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O 7 x ™ ] sleix
[ Ede Edit Mirw Jelect Lit Herarchy Dwsign Sghemaiic Aftibutes Timing Test Window Helg =l
I s e M T A el e |
— [—
& | Logica Hisrarchy Cilis {Hinrarchical) =
| =D RisC_cors CeliName | et ame | cen Patn | Dont Tawen |
y ¥ l?l STACK_TOP ¥_TOFSTACK_TOP |_STACK_TOF  undefined
[EH_REG_FILE FILE REG_FILE LREG_FILE  undafined
(#| -T2 PROAM_CNT TOR M. PRGRM_CNT_ |_PRGAM_CNT
[EH_INSTRN_LAT BIETRAN L. BETRN_LAT  _INSTRAN_LAT  um

ELDATA_PATH DATA_PA_ DATA_PATH | _DATA_PATH  undefine
CONTROL  CONTROL LCONTROL  undafined

ELALY ALL ALy ndufinad

) _CONTROL
AR

STACE MEM’. (MDL-193)

in file

pong/ AT Eup torsal FETACK_MEN, vhit
] Fegqister Name ] Type | Wadth | Bus | BB | AR | A5 | SR | S5 1 ST |
| StockMemreg | Flipflop | 3 | Y [N | B |H [N [N I¥ 1

Inferred memory devices in process
in routine STACK_MEN line 51 in file

pong. fhih Fup @ 1/ FSTACK_MEK, vhd

| Fegister News | Type | Wedeh | Bus | NS | AR | AS | SR | 55 1 ST |

| Poplatsoutreg | Flip-flop | 4 | Y |E | W | N [N [N 1N |

Cureent design 13 mev ‘RISC_CORE®

design_visten-t -
T — | '
ey [Fistory [ Eren¥amings |
design_vision=t> [

[Selacten (13

Figure 1-7 : Main Window After Elaboration Step

Now that we have elaborated the design, we see some basic structure of the design in the
main window of Design Vision. The left pane of the main window shows the full
hierarchy of the design starting from the design that is specified as the top-level (from the
drop-down box in the top tool panel). In the right pane we can select what we see to help
perform later tasks. By right clicking on a module, we may also choose to see a
schematic view from the right click menu. The schematic view may be useful, but
requires a good understanding of synthesis, as the module names may seem cryptic at
first.
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Lesson 2 - Simple Synthesis

Now that we have analyzed and elaborated the design, we can perform simple synthesis
on our design. In ECE 551, we will require the use of design constraints which will be
covered in Lesson 3, however we may see some information about the design by
performing an unconstrained compilation.

In mapping options we may specify mapping and area effort. Map effort refers to how
long the synthesizer will work towards a better organization of the cells before moving on
to the next stage. Area effort refers to how long the synthesizer will try to reduce the area
of the design before moving on to the next stage. Power effort indicates how long the
synthesizer will try to optimize the power used by your circuit Other compile options are:

1. Top Level — compiles only the top level of the design, leaving the rest uncompiled

2. Ungroup All — Ungroups the entire hierarchy so that all logic is compiled as one
module

3. Scan — Refers to the insertion of scan chains for testing logic. This should not be
used for this course.

4. Incremental mapping — specifies that the mapping should be done based upon
only local information instead of global information. Furthermore, if some
mapping information is already available, the synthesis will start from the
previous map. This is especially useful when trying to improve upon an initial
synthesis

5. Allow boundary conditions — allows that boundary conditions such as known
input constants can be used to help optimize the design

6. Auto Ungroup —when enabled, you may choose either area or delay as the trigger,
and the synthesizer will automatically ungroup designs to meet constraints if the
constraints are not being met for the trigger

Design->Compile Design
Leave options as is and click OK

Compile

—Compik oplians
I Top ewal | Insremenial mapping

r Ungraup all | | Allaw boundany condilion=s

flap chlrI:I medium ;I r Scan [ duta ungraup
Arsa eHUrI:I madium j [ e e

i £ ey
Paower sllad: I medium ;I

—De=ign ruke oplians
¥ Fixde=ign le= and oplimize mapping
" Optimiza mapping anky
" Fizdesian ks anly

" Fir hald fima anbe

La3 I Gancsl| | Apphy

Figure 2-1 : Compile Design Dialog

&
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Compile Ultra uses the same options, which have the same meaning as previously
described. The difference is that all effort options are automatically set at their highest
levels and the synthesizer automatically picks options to achieve the best results.
Compile Ultra should be used carefully as it will always take longer time than manually
selecting the options.

Compile Ultra

Figure 2-2 : Compile Ultra Dialog
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Lesson 3 — Design Constraints

1. Check Design

Performing a design check can find inconsistencies in your design that may or may not be
problems. Example check results are having the same input connected to two input ports,
and having ports left unconnected (or certain wires within the port left unused).

Design->Check Design

Change Warning messages to “Display in detail”

Change Hierarchy to “Current level and all sub-designs”
L i

— Check for

Current design: |RISC_CORE

0
(o
[x

— Check options
— Warning messages

 Suppress " Display a summary + Display in detail

— Hierarchy
& Only current level of hierarchy @ Current level and all sub-designs

[ Check for correct back annotation I} Do et ehieck design iteeln

oK I Cancel Apply

Figure 3-1 : Check Design Dialog Box

The following are some of the warnings that given by the check design command. Note
that what is given are warnings. This means that you should check the warnings to
ensure they are expected and ok, or change code and/or Design Vision settings before
moving on.

Warning: In design "RISC_CORE", a pin on submodule "1 _STACK TOP" is
connected to logic 1 or logic 0. (LINT-32)

Pin “PushDataln[11]" is connected to logic O.
Warning: In design "CONTROL®", port "Crnt_Instrn[29]" is not connected
to any nets. (LINT-28)

At this point, the module “STACK_MEM?” is instantiated 3 times. In design vision, we
need each instantiation to be unique so that each instance can be optimized and mapped
separately. To do this, we use the function “Uniquify”

Select RISC CORE in the logical hierarchy in the left pane
Hierarchy->Uniquify->Hierarchy
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Ll o [=][=][x]

Cell reference name: I j

ﬂasenamefnrneuxdeﬂgns:l

[T Instances to be renamed even if unigue or agsigned dont_touch

i I Cancel apply

ELLLL

7

Figure 3-2: Uniquify Hierarchy Dialog
Click OK

This is also done automatically during compilation.

2. Specify Clock

Specify clock tells design vision the clock rate at which the design should be able to
operate. This goal will tell design vision to make sure to organize the modules such that
calculations can all be performed within the clock period. Various technigques such as
logic duplication are used to achieve the goals. It is important to set realistic goals for the
clock rate so that design vision does not perform too much logic duplication to attempt to
reach the goal.

Choose Ports/Pins in the Hierarchy Window Drop down box
Select RISC CORE in the logical hierarchy in the left pane
Find Clk and select it

Attributes->Specify Clock

Specify Clock

Clochk nams: ICIk

Pod names: ICEII\

H Bemowa clock

—Clack creatian

Pariod: l4
Edge | Walus | Add edge pair |
Ri=ing | 0.000
Ramaove adgs pair
Faling 2 000 ;”I
Invad wawvs fom |
0.00 200 4.0(
¥ Dant {ouch netwark ™ Fix hold

i OF I Cancsl | Apphy |

Figure 3-3 : Specify Clock Dialog Box
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You will know if you have correctly selected Clk based upon if Clk shows up in the
grayed out Port name box. If that box is empty, be sure to close this dialog and make
sure Clk is selected before opening this dialog. Since a clock is a signal we don’t want to
optimize (prevents errors of the synthesizer disconnecting the signal), we want to set the
clock as a “don’t touch” network. Select Don’t touch network before clicking OK.

3. Set Input delay

Input delay tells design vision that a signal will always arrive at a certain time relative to
the clock. When specifying delay, the delay should always be specified relative to a
clock so that design vision may calculate delays correctly. Change the drop down box to
Pins/Ports.

Select->Ports/Pins->Input Ports
Find Clk and Ctrl->Click to unselect it

(we want all input ports except Clk selected)
Attributes->Operating Environment->Input Delay

If you did not select any signals, either the Input Delay option in the menu would be

grayed out, or there would be no entries in the Name field.
Select Clk in the Relative to clock dropdown
Specify 2 as the Minimum and Maximum delay

This means that input signals should be modeled so that they arrive 2nS after the edge of
clk.

Click OK

o T BB

Iame: |trn[1 8] Instrn[11] Instrn[d] Instrn[27] Instrn[20] Instrn(1 3]

Relative to clock: | Clk =]

& Rising edge " Ealling edge

hax rise: k ke fall: k
kdin rise: |2 din fall: |2

[T add delay

Ok, I Cancel | Apply |

2

Figure 3-4 : Input Delay
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4. Output Delay

Similar to input delay, we must also specify how long an output signal takes to reach the
chip’s output with respect to the clock. This specifies how long a signal takes to reach
the chips output after leaving your modules output.

Select->Ports/Pins-> Output Ports
Attributes->Operating Environment->Output Delay
Specify 0.5 as the Minimum and Maximum Delay

Click OK

|| =r 8 —|(8]|x]

Mame: [|ecutng_Instrn[16] RESULT_DATAZ] Kecutng_Instrn[9]

Relative to clock: | CIk =]

¢ Rising edge ~ Ealling edge

¥ Same rise and fall

M&KME:IS hel 2 fall: IE
kdin rise: |.5 rin fall: |.5

[~ Add delay

O I Cancel | Apply |

)

Figure 3-5 : Output Delay
5. Wire Load

We must specify a wire load model so that design vision can estimate the delay that wires
in the design have. Each model is based upon a different amount of resistance and
capacitance for a certain amount of wire. Design vision will use that amount to estimate
how much delay is added to the circuit based on the length of the wires and distance
between the wires.

Attributes->Operating Environment->Wire Load
Select B1X1l and Click OK
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B  wreload =Y

Current design: |proc

Wire load maodel: |B1}{1 [ gfl<p )

<MNOMNE

BO. 101 { gflep )
BO.2X0.2  (gikp)
BO.3X0D.3  (gflkp)
BO.4X0.4  (gikp)
BO.5X0.5  (gilkp)
BOGX0E  (gikp)
BO.7X0.7  (gilkp)
BO.GXDE  (gflkp)
BO.GX0.98  (gikp)
B 1K1 { gfl<p )
Bi5X15  (gikp)
Bax2  (gflkp)
B3X3  (gikp)
BaXd  (gikp)

oK I Cancel Apply

Figure 3-6 : Wire Load Model
6. Operating Conditions

We may specify either single analysis or min/max analysis. Our choice for this option
depends upon whether our synthesis library contains one set of analysis information or it
contains a set of information for both minimum and maximum cases.

Attributes->Operating Environment->Operating Conditions
Select gflxp as the library and NOM as the Condition, Click OK

| Operating Conditions

Cument design: [R50 DORE

—Analy=iE condilian
£+ Singk " Min/max cass

— Maximum operaling condilion —————— |~ Minimum oparaling condilian
Lbrany: I gllp j Lbrany: I allp J
Candtion: ([HEY - Gondiian: | 101! I

164 I Cancsal | Apphe |

Figure 3-7 : Operating Conditions
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7. Driving cell

We must specify which cells drive the circuit, and with what strength.

Select->Ports/Pins->Input Pins

Find and Ctrl->Click Clk to deselect it
Attributes->Operating Environment->Drive Strength
Click “Use library cell options”

Click the . button

Expand gflxio, find DDRVLS33 and select it
Click the Click to Choose Objects and Click OK
Click OK

BTRE6JLS33
BTR75JLS33
DDRVDILS33

IR ILERUTES

MR LTS

Figure 3-9
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8. Top level Constraints

This level of constraints allows us to set overall objectives of the design for design vision
to attempt to reach. We can set maximum values for area, power, fanout, and transition.
Normally for this course we will only set values for area and fanout, allowing power and
transition to vary as design vision likes. This will speed our synthesis time and will allow
us to concentrate on the operation of the circuit rather than worrying about power and
other effects that require attention after full correctness is guaranteed.

Attributes->Optimization Constraints->Design Constraints
Enter 380000 in the Max Area, click OK
- T - =|2]x|

Current design: IRISC_COHE

— Optimization constraints

hax arga : ISBDEIDD
Max dynamic power: I
hax leakage power: I

— Design rules

Max fanout: |

kdax transition: |
1,4 I Cancel | Apply |
—

Figure 3-10 : Design Constraints Dialog

9. Output Port Attributes

This option allows us to specify that an output is to be left unconnected or change the
signal type. The other signal types available are primarily for use with JTAG (Joint Test
Action Group) which allows insertion of testing abilities. We will not need to modify the
signal type in this course.

This dialog can be found by doing the following:
Select->Ports/Pins->0Output Ports
Attributes->Optimization Directives->Output Port...

B]  oOutputPortAttributes =l
Part name: |dr[2?] addr[20] addr[13] addr[B]

Maximurn transition: |
[T Port is pad

Paort Pad Attributes. . |
[~ Unconnected

Signal type:

Ok I Cancel | Apphy |

4

Figure 3-11 : Output Port Attributes Dialog
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10. Input Port Attributes
This option allows us to specify different conditions on each input port. We do not need
to modify these properties for this course

a.

Maximum fanout — The maximum number of wires that this input can
drive before requiring buffers. For example if the max is 10 and we need
to connect 100, we connect each of the 10 to a buffer and each of the
buffers are connected to 10 of the overall 100.

Maximum transition — The maximum amount of time for the signal to
transition from a value to the next value. This allows Design Vision to
choose drive strength appropriately to meet the requirement.
Maximum capacitance This setting is not used for ECE 551

Port is pad — Sets the port of the design as a chip level input. This setting
is not used for ECE 551

Disable timing This setting is not used for ECE 551

Don’t touch network — Tells Synopsys to not modify the network that is
specified by the port. Commonly used for Clock and Reset networks
which are typically given resources separately from the synthesis process.
Connected to — Allows you to specify that a port is connected to 0, 1 or is
exactly the same or exactly opposite of another port. This helps the
synthesis process by allowing Design Vision to simplify logic that is
connected to these ports.

Test hold — For use with on chip testing features, not used for ECE 551.

Signal type — For use with on chip testing features, not used for ECE 551

This dialog can be found by doing the following:
Select—>Ports/Pins—>Input Ports
Attributes->Optimization Directives->Input Port...
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Part name: ia[Q] data[25] data[18] data[11] data[4]

M axirmum fanout ||—
Maximum transitian: l—
Maximum capacitance l—

Paort options
" Portis pad

Port Pad Aftributes. | I~ Disable timing

™ Daon't touch network

Connected to

I Logicd Set Oppasite
I Logic 1 Set Equal
Test hold: |N0ne j
Signal type: |None j

[o]:8 I Cancel | Apply |

i

Figure 3-12 : Input Port Attributes

11. Port Pad Attributes

This option allows us to specify how the output (or input) pin on the actual chip will be

used. This specification allows design vision to insert (or remove) appropriate logic so

that our design operates as expected when placed on chip. This option is not needed for
ECE 551 and should not be used.

We have now specified all of the constraints on our design. Before moving on to Lesson
4, you should resynthesize so that the reports you generate will have realistic and
interesting data. You may want to revisit Lesson 2 to review the synthesis process.

Additional Constraints that may be used to aid in specifying what kind of optimizations
to be performed are found in Appendix B.

When we are using the same constraints repeatedly, we can save the constraints into a
script file and simply execute the script. The commands for the file can be taken directly
from the commands that are echoed to the log when we executed from the GUI before.
To execute a script:

File->Execute Script
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Lesson 4 — Reports

We have now finished the entire synthesis process, but need to analyze the results of the
synthesis to determine if we need to change code to achieve our goals, or verify that goals
have been met. These reports can also be used to offer comparisons of several synthesis
attempts. See Appendix C for example results of each of these reports

1. Report Design — This report specifies top level design constraints, such as the
library that was used for synthesis, wire load, and operating conditions.

Design->Report Design

|

S

=||o)ix]|

— Report for

Current design:

RISC_CORE

— Report options

™ Mo line split

— Qutput options
W Toreport wiewer

I/ Tofile: [Report

| Append tofile

Erowse. |

Cancel |

apply |

Figure 4-1

2. Report Design Hierarchy — This report will give the entire hierarchy of the design,
listing each instance that is used at each level of the hierarchy. In this case we
have selected the list first instance option so that in portions of our hierarchy
where the same module may be used many times it will be listed only once.

Design->Report Design Hierarchy

|

S

=lia]x]

— Repart for

Current design:

|RISC_CORE

Current instance: |

— Report options

[~ Mo line split

’7(3' List first instance

For multiple instance submodules

¢ Ligt all instances

— Output options

¥ To report viewer

I/ Tofile: [Report.txt

| Eppend o file

Erowse.. |

Cancel |

Figure 4-2
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3. Report Reference — This report lists all of the references (modules) instantiated on
the top level of the design and their corresponding area. This report allows the
user to see which modules of their top-level design contribute the most to the
overall area of the design.

Design->Report Reference
L . [=l[=]x]

— Repaort for
Current design: IHISC_COHE

Current instance: I

— Report options
¥ Mo line split

— Dutput options
¥ To report viewer

I Tofile: |Repnr‘[_tx1 Erosen. |

v Anpend tofile
Ok I Cancel | Spply |

Figure 4-3

24

4. Report Wire Load — This report lists the wire loads in the design (listing both the
wire load model used and some information on the relative occurrence of different
amounts of fanout). Note that this report is included in the Report Design report.

Timing->Report Wire Load

L] s [=I[=][=]
— Report options
[T Mo line split [~ Report models in the linked libraries
Design name: |RISC_CORE =]
& &l models
© single model.  [E00 [7]

— Qutput options
v Toreport wiewer

[~ Tofile: |F-!epur1_tx1 ErowzeL., |

Iv | Eppemnd tafile
Ok I Cancel | Apply |

Figure 4-4
5. Report Ports — This report is generated based upon the ports that you currently

have selected, or you may manually type the names of the ports or use the @l
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button to search for the ports you wish to be included in the report. The report
will include capacitive load, input or output delay that has been specified,
transition time and resistance. Not all of these items may have been calculated or
specified depending upon the library you used, so the report will give whatever is
available.

Design->Report Ports

Report Ports
DATA[Z] Kecutng_Instrn[d] Instrn[13] E’?‘. I

s

JFeparted

[ | Appenl o file

Figure 4-5

6. Report Cells — This report specifies each cell and also shows the connections
between cells. For example, the report can show what pins are outputs of a cell,
and what library cell type is connected to that output (to see whether the outputs

are registered).

Design->Report Cells

Report Cells

Figure 4-6
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7. Report Nets — This report shows direct connections of nets, including transition
times, capacitance, resistance, number of input drivers, and number of outputs
(fanout).

Design->Report Nets

Report Mets

d_A[F] Oprd_A[D] Cprnd_A[9] Oprnd_A[Z] IETE I

I | Appetil o file

Figure 4-7

8. Report Clocks — This reports the properties of all clocks in the system. This
includes clock rate (including duty cycle), and clock skew if there is any.

Design->Report Clocks

Report Clocks

Figure 4-8
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9. Report Area — This reports the final area of the design, showing sub values for the
amount of combinatorial logic, sequential logic, and interconnect.

Design->Report Area

Report Area

Figure 4-9

10. Report Compile Options — This reports the compile options used for each module
in the design (specifically flattening, and structuring).

Design->Report Compile Options

Report Compile Options

Figure 4-10

11. Report Power — This reports the amount of power consumed in the design. The
report separates static and dynamic power. This option will not be necessary in
ECE 551 but may provide an interesting comparison.
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12. Path Slack

This report shows a histogram of paths in your design (basically all nets with a
constrained timing path such as between the output of one FF and the input of another)

Timing->Path Slack

We will leave everything as it is in Figure 4-11 but note that there are additional settings
we could use to change the paths that are included in the output histogram or change the
appearance of the histogram.

[ - =] (=] [x]
— Paths

From: | pin jl @ Eelectinn]i] |
Thraugh: |pin jl @ Eelectinn(z] |
To: [pin =] @ EelentinnE] |

Y

nwarst paths: |10 = Max paths: |50 =

Eroup name: I v| Delay type: Imax v|

[~ Enable preset clear arcs [¢ Include hierarchical pins

— Binning settings

& MNumber of hins: |8 3:
" Walue range per bin: I

| <= Slack <= |

[~ Lower bound strict [~ Upper bound strict
— Histogram settings

Y masimum; {autoscale) =

Histogram title: |F'ath Slack

H-ads title:  [3lack

¥ - axis title: |Number of Paths

Ok I Cancel apply

Figure 4-11

N
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Path Slack Slack |Frem To

‘Humber of Paths

T T T e
14 ‘1.404 |T.408' |1..412 . ‘1.415 142 .
Slack
Worst Best
1.40086 | 1 42243

T Hierd | 3 Hisilist 1 Pains._ |

Figure 4-12

13. Endpoint Slack
This report is similar to path slack, except the only paths shown in this report are
endpoints (the path ends at the output of a module or is unconstrained after the end of the
path)

Timing->Endpoint Slack

Note that the choices available for endpoint slack are less than that of the path slack
report. We will again leave the defaults for the tutorial.
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o

W =l

Delay type: I fmas vl
— Binning settings
& Mumber of bins: |3 =

 Malue range per hin: I
I <= Slack == I

[~ Lowsr bound strict [T Upper bound strict

b

— Histogram settings
W maximum: {autnscale) =

Histogram title: [Endpoint Slack
H-anis title: ISIack

Y- gz title: INumher of Paths

Ok I Cancel | apply

Figure 4-13

Endpoint Slack

Slack |Mame

[lnbsethahs:

| 140086 [

14. Report Timing Paths

34708

Figure 4-14

Report timing paths is one of the most important reports for ECE 551 and in general. We
will leave the report options at the defaults. When left at default, the report will give us
the worst path delay in our entire design. If this report shows that we have met our clock
speed constraints, then we know the entire design can run at the clock speed.
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Timing->Report Timing Path...

L wr - =ll8l[x|
— Paths

From:  |pin =] @ Zeleatian(il] |
Thraugh: | pin ]| @l SelECtinnZ] |
To: |pin j| @l Zeleatinn]a] |

— Report options

Worst paths per endpoint: |1 Maximum path delay: I
kax paths per group: |1 Kinimum path delay: I
Path type: | ful =]

[~ Report timing loops

Delay type: | max hd [~ Justify paths with input vectar

. Find true path
setby o o r p
(= = N = e IIZI
Significant digits: |2 3: B 2 I

[T Mo line split [~ Enable asynchronous arcs
[T Show nets in combinational path [~ Show net transition time
[~ Show input pins in combinational path [T Show net capacitance

[~ Show dont_touch, size_only attributes for nets and cells

— Output aptions
¥ To report wiewer

[T Tofile: |F~!ep0r1.t>;t Efiyse.., |

v | Enpend to e

Cancel | Apply |

Figure 4-15

Because of the importance of this report, an example is included here rather than in
Appendix C.

How to read this report: The first section starts at the output of a flip flop or primary
input (Reset in this case) and lists a time (0 nS). The report then specifies each gate
between this flip flop output and the d input of the flip flop at the endpoint
(I_ALU/Zro_Flag_reg). It lists an incremental delay and total path delay at each step so
that if you need to re-optimize the design, you know which types of gates to try and
remove from the path. (In this case no gate or unit is particularly expensive but in some
cases we see an obvious choice such as having two multipliers on the path). At the end a
“data arrival time” is listed. In this example data arrival = 2.35 nS.

After that the “data required time is calculated. The data required time will be the clock
period we were trying to achieve, with time subtracted to account for the setup time a
DFF needs and potentially clock skew if we have specified any. In this example data
required time = 3.75nS.

Page 27 of 65



We then compare data required time to data arrival time and see that the clock speed
constraint has been met and we have a slack (extra unused time) of 1.40nS. When listing
our achievable clock rate, we can say our design has a maximum clock speed of (4nS
(attempted) — 1.40nS (slack) = 2.60nS clock period). If we had not met the slack, the
statement would say “slack (VIOLATED)” in which case we must add the time listed to
our attempted clock rate. In general, if we do not meet our clock speed constraint, we
should change the constraint and resynthesize, so that we only list achieved clock rate
based upon a successful synthesis.

Report : timing
-path full
-delay max
-nworst 5
-max_paths 5
-sort_by group
Design : RISC_CORE
Version: Z-2007.03-SP3
Date : Wed Oct 3 13:18:47 2007

Operating Conditions: NOM Library: gflxp
Wire Load Model Mode: enclosed

Startpoint: Reset (input port clocked by CIk)
Endpoint: 1_PRGRM_CNT_TOP/1_PRGRM_CNT/PCint_reg[O]
(rising edge-triggered flip-flop clocked by CIk)
Path Group: CIlk
Path Type: max

Des/Clust/Port Wire Load Model Library
RISC_CORE B1X1 gflxp
PRGRM_CNT BO.1X0.1 gflxp
Point Incr Path
clock Clk (rise edge) 0.00 0.00
clock network delay (ideal) 0.00 0.00
input external delay 2.00 2.00 F
Reset (in) 0.00 2.00 F
I_PRGRM_CNT_TOP/Reset (PRGRM_CNT_TOP) 0.00 2.00 f
I_PRGRM_CNT_TOP/1_PRGRM_CNT/Reset (PRGRM_CNT) 0.00 2.00 f
I_PRGRM_CNT_TOP/1_PRGRM_CNT/U15/Z (NR2M1P) 0.05 2.05r
I_PRGRM_CNT_TOP/1_PRGRM_CNT/U3/Z (NR2BNM1P) 0.20 2.25 r
1_PRGRM_CNT_TOP/1_PRGRM_CNT/U14/Z (AOI22M1P) 0.07 2.32 f
I_PRGRM_CNT_TOP/1_PRGRM_CNT/U23/Z (AO21CNM1P) 0.03 2.35r
I_PRGRM_CNT_TOP/1_PRGRM_CNT/PCint_reg[0]/D (FD1LQM1P)

0.00 2.35r
data arrival time 2.35
clock Clk (rise edge) 4.00 4.00
clock network delay (ideal) 0.00 4.00
1_PRGRM_CNT_TOP/1_PRGRM_CNT/PCint_reg[0]/CP (FD1LQM1P)

0.00 4.00 r
library setup time -0.25 3.75
data required time 3.75
data required time 3.75
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data arrival time -2.35

slack (MET) 1.40

15. Net Capacitance

Timing->Net Capacitance...

This option is not needed for ECE 551.
16. Check Timing
Timing->Check Timing. ..
This report performs a check of the timing constraints specified and gives potential
errors. This report can be used for ECE 551 but is typically less accurate than post

synthesis simulation in Modelsim, which will be covered later.

17. Report Clock Skew

Timing->Report Clock Skew. ..

This option is not needed for ECE 551.

18. Report Clock Tree

Timing->Report Clock Tree...

This option is not needed for ECE 551.

19. Report Path Group

Timing->Report Path Group...

This option is not needed for ECE 551.

20. Report Timing Constraints

Design->Report Constraints...

This report lists all timing constraints you have specified. This report tends to list more
information than previous equivalent reports. The extra information is not needed for
ECE 551.
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Appendix A— Synopsys Code Directives

1."ifdef — if the following macro is defined include the code

2. else — code to include otherwise

3."endif — the end of the if statement

4. define — creates a macro

5. elsif — combination of an else and if

6. ifndef — if the following macro is not defined, include the code

7.7 include — includes the specified file

8. undef — undefines the macro (usually used in advance of redefinition

9. undefineall — undefines all macros

10.//synopsys translate_on — turns on the synthesis translation

11.//synopsys translate_off — turns off the synthesis translation

12.//synopsys parallel_case — specifies that the following case statement is purely
parallel (i.e. only one case will execute, it is not possible for multiple of the cases
to be true)

13.//synopsys full_case — specifies that the following case statement includes a
statement for all of the possible combinations of the input select variables. This
option should not be used in place of actually specifying all possibilities.

14.//synopsys state_vector — specifies that the following code is a state_vector

15.//synopsys enum — enumerates a list of variables and automatically assigns
sequential numbers to the list

16.//synopsys template — specifies that the module is a template

17.//synopsys dc_script_begin — allows the inclusion of Design Compiler scripts
within the code of your verilog

18.//synopsys dc_script_end — the end of the Design Compiler script
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19.//synopsys map_to_module — specifies that the code be mapped to a particular
module

20.//synopsys return_port_name — specifies the name of the return port (not necessary
for normal code, this is an advanced feature for less common code styles)
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Appendix B — Extra Optimization

1. Design Attributes

We may also specify design attributes, either on a module by module basis, or for the
entire design at once.

1.Ungroup
Ungroup refers to the fact that this is a module. If we choose to ungroup, Design
Vision will take all of the logic within the module and combine it with the logic at
other levels of the design. This can obtain area benefits by possibly combining
redundant logic.
2.Don’t touch
Don’t touch tells Design Vision to not alter the design as is. This is an option that
can be used if the module is already synthesized and you do not want any changes
made to the design. It is commonly used when a module is already optimized and
we want to prevent changes that may result in a worse design
3.Boundary Optimization
Boundary Optimization is similar to ungroup except it only allows design vision
to optimize the logic on the interface (Inputs and Outputs) of modules rather than
allowing all internal logic to be possibly combined with other logic.
4.Disable wired logic(ECL)
This option refers to a style of connections which allows logic to be performed
simply by connecting several wires together. We will never want wired logic for
this course, so the option should always be checked.
5.Sequential elements
These options allow us to chose specific modules out of the library to be used
within the design. This ability is an advanced feature that we will not use in this
course.
6.Flatten logic
Flattening of logic takes multi-level logic and duplicates as many gates as
possible to yield logic that is larger but potentially much faster.
a) Flatten Effort
This refers to how long design vision will allow the algorithm to run before
moving on to the next portion. All algorithms of this type are non-
deterministic (i.e. there is no exact solution, and no algorithm exists that can
guarantee an optimal solution — also called NP-Complete). This effort refers
to how long the algorithm is allowed to run without achieving positive results
before we consider our solution as optimal.
b) Flatten minimize
This refers to whether we want the logic to try to minimize delay for only the
most critical output, all of the outputs or none of the outputs.
c) Flatten phase
(i) Apply strategy — inverts the phase of the output during optimization
(if) Don’t apply — doesn’t invert the phase of the output
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7.Structure logic
Structuring determines whether structuring constraints are set in this design.
a) Timing driven structuring — restructures the design to achieve better timing
b) Boolean optimization — restructures the design to minimize the Boolean
equations specified by the logic

Attributes->Optimization Directives->Design

Design Attributes

(0 I e £ Higi

£ 0 [ L s A =2

Figure 4-16 : Design Attributes ialog

2. Cell Attributes

Ungroup

Don’t Touch

Allow Boundary Optimization
Sequential Elements

Max Time Element

Scan Replacement

~® 00T
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Cell Mame
RAef Mame alu
Cell Path al

dont_tauch undefined
is_mapped true
is_seguential false
cell_library

Figure 4-18 : Cell Properties
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Appendix C - Reports Output
1. Report Design

R R R e R R R R R AR AR R R AR R AR AR AR R AR AR R AR R R AR R R

Report : design

Design - RISC_CORE

Version: 2003.06

Date - Mon Sep 13 13:35:33 2004
AEAIAAAXAXAAAXAAAXAXAAXAXAAAXAXAAXAAAAXAAAAAAAXAAAXAA)K
Design allows ideal nets on clock nets.
Library(s) Used:

gflxp (File:
/usr/apps/eda/flexstream.3.3/1si_fTs_3.3/1i1b3p/synopsys/gfixp/gflxp_Isi_
wc.db)
Local Link Library:

{gflxp_Isi_wc.db, gflxio_Isi_wc.db}
Flip-Flop Types:

No Flip-flop types specified.
Latch Types:

No latch types specified.
Operating Conditions:

Name Library Calc_mode Process
Temp Volt Interconnect
Model
LSI_wC gfFlxp 1.32 115.00 1.08 balanced_tree

Wire Loading Model:

Selected manually by the user.

Name : B1X1 *
Location : gfFlxp
Resistance : 0.000569
Capacitance : 0.000167
Area : 0.095862
Slope : 54.8
Fanout Length Points Average Cap Std Deviation

1 24.80

2 81.00

3 137.30

4 193.50

5 249.70

6 306.00

7 362.20

8 418.50

9 474.70

10 531.00

Wire Loading Model Mode: enclosed.
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Timing Ranges:

No timing ranges specified.
Pin Input Delays:

None specified.
Pin Output Delays:

None specified.
Disabled Timing Arcs:

No arcs disabled.
Required Licenses:

None Required
Design Parameters:

None specified.

2. Report Design Hierarchy

FAEAIAIAAXAAAAXAAAXAAAAAAAXAAAALAAAXAAAAAAAAdAihix

Report : hierarchy
Design : RISC_CORE
Version: 2003.06
Date - Mon Sep 13 13:36:29 2004
R R e S e e R R R e e e R e R e R e R e e e e e R e R e e
RISC_CORE
ALU
ALU_DWO1_addsub_16 O
AND2M1P
AOI21M6P
ENFM1P
ENFM2P
EOFM1P
EOFM2P
NIM1P
N1M2P
ND2BNM1P
ND2BNM2P
ND2M1P
ND2M2P
OA21M1P
OAI21M1P
OAI121M2P
OA121M4P
ALU_DWO1 addsub_16 2
AOI21M1P
AOI21M2P
ENFM1P
ENFM2P
EOFM1P
EOFM2P
NIM1P
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gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp

gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp



N1M2P gflxp

ND2BNM1P gflxp
ND2BNM2P oflxp
ND2M1P gflxp
ND2M2P gflxp
NR2BNM1P gflxp
NR2BNM2P gflxp
NR2M1P gflxp
NR2M2P gflxp
NR2M3P gflxp
OA21M1P gflxp
OAI21M1P gflxp
OAI21M2P gflxp
AND2M1P gflxp
AND2M2P gflxp
AO21CNM1P gflxp
AO21CNM2P gflxp
AO21M1P oflxp
AO22M1P oflxp
AO211M1P oflxp
EOFM1P gflxp
FD1LQM1P gflxp
FD1SLQM1P oflxp
MUX21HFM2P oflxp
MUX21HM1P oflxp
N1M1P gflxp
N1M2P gflxp
N1M4P gflxp
ND3CNM1P oflxp
ND3CNM2P oflxp
ND8M1P gflxp
NR2M1P gflxp
NR3M1P oflxp
NR8M1P gflxp
OA21M1P gflxp
OR2M1P gflxp
OR2M2P gflxp
OR2M4P oflxp
OR2M8P oflxp
OR2M10P gflxp
OR3M1P gflxp
OR3M2P gflxp
OR3M8P gflxp
BUFM1P oflxp
BUFM2P gflxp
CONTROL
AND2M1P gflxp
AND2M4P oflxp
AND3M1P gflxp
AND3M4P gflxp
AO21CNM1P gflxp
AOI1211M1P gflxp
BUFM10P gflxp
EOFM1P gflxp
FD1QM1P gflxp
FD1SQM1P gflxp
FD1SQM3P gflxp
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MUX21HM1P
N1M1P
NDSM1P
ND6M2P
NR211M12P
NRSM1P
OR2M1P

DATA_PATH

AND2M1P
AO22M1P
FD1LQM1P
FD1SLQM1P
FD1SLQM3P
MUX21HM1P
MUX21HM2P
N1M1P
ND2BNM1P
ND4CDNM1P

NR2M1P
NR2M2P
NRAM1P
OR2M2P
OR3M1P
INSTRN_LAT

FD1LQM1P
FD1LQM3P

PRGRM_CNT_TOP
PRGRM_CNT
AO222M2P
FD1LQM1P
FD1LQM3P
NIM1P
NR2M1P
NR3M2P
OR2M1P
OR3M1P
PRGRM_CNT_DWO1_inc_8_0

EOFM1P
HA1M2P
N1M1P

PRGRM_DECODE
AND2M1P
AND3M1P
AND4M1P
EOFM1P
MUX21HM1P
MUX31HM2P
N1M1P
ND2M1P
ND3BCNM1P
ND4CDNM1P
NR6M2P
OR2M1P
OR3M1P

PRGRM_FSM
AND2M1P
AND3M1P
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gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp

gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp

gflxp
gflxp

gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp

gflxp
gflxp
gflxp

gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp

gflxp
gflxp



FD1QM1P
MUX21HM1P
NIM1P
NR2M1P
REG_FILE
AO22M1P
FD1LQM1P
NIM1P
NR2M2P
OA12222M1P
OR2M1P
OR2M8P
STACK_TOP
STACK_FSM
AND2M1P
AND3M1P
AND4M1P
AO21CNM1P
AO211M1P
ENFM1P
EOFM1P
FD1LQM3P
FD1QM1P
FD1QM3P
MUX21HM1P
N1IM1P
NR2BNM1P
NR2M1P
NR3M1P
0A21M1P
OR2M1P
OR3M1P
STACK_MEM_O
BUFM3P
ENFM1P
EOFM1P
FD1LQM1P
MUX21HM1P
MUX21LM1P
NIM1P
ND2M1P
NR2M1P
NR3M1P
NR3M2P
0A2222M1P
OR3M1P
STACK_MEM_1
ENFM1P
EOFM1P
FD1LQM1P
MUX21HM1P
MUX21LM1P
NIM1P
ND2M1P
NR2M1P
NR3M2P
0A2222M1P
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gflxp
gflxp
gflxp
gflxp

gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp

gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp

gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp

gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp
gflxp



OR3M1P gflxp
STACK_MEM_2
ENFM1P gflxp
EOFM1P gflxp
FD1LQM1P gflxp
MUX21HM1P gflxp
MUX21LM1P gflxp
N1M1P gflxp
ND2M1P gflxp
NR2M1P gflxp
NR3M2P gflxp
0A2222M1P gflxp
OR3M1P gflxp
3. Report Reference
R R e e R e R R R e e e R e R e R R R e R e e e e e R e e e e
Report : reference
Design : RISC_CORE
Version: 2003.06
Date - Mon Sep 13 13:37:48 2004
R R e o e e R R R e e e R e R e e R e e R e R e e e e
Attributes:
b - black box (unknown)
bo - allows boundary optimization
d - dont_touch
mo - map_only
h - hierarchical
n - noncombinational
r - removable
s - synthetic operator
u - contains unmapped logic
Reference Library Unit Area Count
ALU 4401.900391
BUFM1P gflxp 4.001200
BUFM2P gflxp 5.001900
CONTROL 331.057709
DATA_PATH 1620.130859
INSTRN_LAT 1921.102661
PRGRM_CNT_TOP 735.097717
REG_FILE 3522 .355469
STACK_TOP 5975.694824
Total 9 references
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4401.900391
132.039612
5.001900
331.057709
1620.130859
1921.102661
735.097717
3522 .355469
5975.694824

18644 .380859

Area Attributes



4. Report Wire Loads

R o e R R A R R AR AR R AR SR R R R R R R R R R R AR

Report : wire loads
Design - RISC_CORE

Version: 2003.06

Date - Mon Sep 13 13:58:25 2004

R e R AR R o R AR R R R Sk R e R e e R e

Wire load model: BO.1X0.1

Location : ALU_DWO1_addsub_16_2 (design)
Resistance : 0.000569
Capacitance : 0.000167
Area : 0.095862
Slope : 8.9
Average Standard % Standard
Fanout Length Points Cap Deviation Deviation
1 0.50
2 9.60
3 18.80
4 27.90
5 37.10
6 46.20
7 55.40
8 64.50
9 73.70
10 82.90
Wire load model: B0O.2X0.2
Location : ALU (design)
Resistance : 0.000569
Capacitance : 0.000167
Area : 0.095862
Slope : 18.4
Average Standard % Standard
Fanout Length Points Cap Deviation Deviation
1 5.60
2 24.40
3 43.30
4 62.20
5 81.00
6 99.80
7 118.70
8 137.50
9 156.40
10 175.20

Wire load model: B1X1

Location : RISC_CORE (design)
Resistance : 0.000569
Capacitance : 0.000167
Area : 0.095862
Slope : 54.8
Average Standard % Standard
Fanout Length Points Cap Deviation Deviation
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1

2

3

4 193.50
5 249.70
6 306.00
7 362.20
8 418.50
9 474.70
0O 531.00

5. Report Ports

EAEXEXAXAEXAXAAAXAAAXAAAXAAAXAAAXAAAXAAAXAAAXAAXAAA)X

Report : port
-verbose
Design : RISC_CORE

Version: 2003.06

Date > Mon Sep 13 13:38:53 2004
Pin Wire Max Max Connection

Port Dir Load Load Trans Cap Class Attrs
Xecutng_Instrn[2]

out 0.0000 0.0000 -- - -
Instrn[6] in 0.0000 0.0000 - - -
PSW[6] out 0.0000 0.0000 -- - -
PSW[9] out 0.0000 0.0000 -- - -
Xecutng_Instrn[25]

out 0.0000 0.0000 -- - -
Instrn[29] in 0.0000 0.0000 -- — -
RESULT_DATA[11]

out 0.0000 0.0000 -- - —-—
Xecutng_Instrn[18]

out 0.0000 0.0000 -- - -
Instrn[22] in 0.0000 0.0000 -- - -
RESULT_DATA[4] out 0.0000 0.0000 -- - -
Xecutng_Instrn[11]

out 0.0000 0.0000 -- - -
Instrn[15] in 0.0000 0.0000 - - -
Xecutng_Instrn[4]

out 0.0000 0.0000 -- - —-—
Instrn[8] in 0.0000 0.0000 -- - -
Instrn[1] in 0.0000 0.0000 -- - -
PSW[1] out 0.0000 0.0000 -- - -
Xecutng_Instrn[27]

out 0.0000 0.0000 -- - —-—
Instrn[31] in 0.0000 0.0000 -- - -
RESULT DATA[13]

out 0.0000 0.0000 -- - -
Xecutng_Instrn[20]

out 0.0000 0.0000 -- - —-—
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Instrn[24] in
RESULT_DATA[6] out
Xecutng_Instrn[13]

out
Instrn[17] in
Xecutng_Instrn[6]
out
Instrn[10] in
Instrn[3] in
PSW[3] out
Reset in
Xecutng_Instrn[29]
out
RESULT_DATA[15]
out
Xecutng_Instrn[22]
out
Instrn[26] in

RESULT_DATA[8] out
Xecutng_Instrn[15]
out
Instrn[19] in
RESULT_DATA[1] out
Xecutng_Instrn[8]

out
Instrn[12] in
Xecutng_Instrn[1]
out
Instrn[5] in
PSW[5] out
Clk in
PSW[8] out
Xecutng_Instrn[31]
out
Rd_Instr out
Xecutng_Instrn[24]
out
Instrn[28] in
RESULT_DATA[10]
out
Xecutng_Instrn[17]
out
Instrn[21] in

RESULT_DATA[3] out
Xecutng_Instrn[10]

out
Instrn[14] in
STACK_FULL out
Xecutng_Instrn[3]

out
Instrn[7] in
PSW[7] out
PSW[10] out
Instrn[O] in
PSW[O] out
Xecutng_Instrn[26]

out

oNoNe) eNoNe] [eNe] [eNoNoNoNe] [eNe] oNoNe) oNoNe] o [eNeoNoNoNe) oo

[eNoNoNoNoNe)

(@)

-0000
.0000

.0000
-0000

-0000
-0000
-0000
-0000
-0000

-0000

-0000

-0000
-0000
-0000

-0000
-0000
-0000

-0000
.0000

-0000
-0000
-0000
-0000
-0000

.0000
-0000

-0000
-0000

-0000

-0000
-0000
-0000

-0000
-0000
-0000

-0000
.0000
.0000
.0000
-0000
-0000

-0000

[eNoNoNoNe] [eNe] oNoNe) oNoNe] o [eNoNoNoNe) [eNe]

oo

[eNoNe]

oNoNe)

o [eNoNoNoNoNe)

-0000 -
-0000 -

-0000 --
.0000 --

-0000 -
-0000 --
-0000 --
.0000 --
-0000 -

-0000 --

.0000 --

-0000 -
-0000 --
-0000 --

-0000 -
-0000 -
-0000 --

.0000 --
.0000 --

-0000 --
-0000 --
-0000 --
-0000 -
-0000 -

-0000 --
.0000 --

-0000 -
-0000 --

.0000 --

-0000 -
-0000 --
-0000 --

-0000 -
-0000 -
-0000 --

.0000 --
-0000 -
-0000 -
-0000 --
.0000 --
.0000 --

.0000 --
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Instrn[30] in 0.0000 0.0000 -— - -
RESULT DATA[12]

out 0.0000 0.0000 -- - —-—
Xecutng_Instrn[19]

out 0.0000 0.0000 -- - -
Instrn[23] in 0.0000 0.0000 -— - -
RESULT_DATA[5] out 0.0000 0.0000 -- — -
Xecutng_Instrn[12]

out 0.0000 0.0000 -- - —-—
Instrn[16] in 0.0000 0.0000 -- - -
OUT_VALID out 0.0000 0.0000 -- - -
Xecutng_Instrn[5]

out 0.0000 0.0000 -- - —-—
Instrn[9] in 0.0000 0.0000 -- — -
EndOfInstrn out 0.0000 0.0000 -- - -
Instrn[2] in 0.0000 0.0000 -— - -
PSW[2] out 0.0000 0.0000 -- — -
Xecutng_Instrn[28]

out 0.0000 0.0000 -- - —-—
RESULT DATA[14]

out 0.0000 0.0000 -- - -
Xecutng_Instrn[21]

out 0.0000 0.0000 -- - —-—
Instrn[25] in 0.0000 0.0000 -- - —-—
RESULT DATA[7] out 0.0000 0.0000 -- - -
Xecutng_Instrn[14]

out 0.0000 0.0000 -- — -
Instrn[18] in 0.0000 0.0000 -- - —-—
RESULT_DATA[O] out 0.0000 0.0000 -- — -
Xecutng_Instrn[7]

out 0.0000 0.0000 -- - -
Instrn[11] in 0.0000 0.0000 -- — -
Xecutng_Instrn[O]

out 0.0000 0.0000 -- - —-—
Instrn[4] in 0.0000 0.0000 -- —- -
PSW[4] out 0.0000 0.0000 -- - -
Xecutng_Instrn[30]

out 0.0000 0.0000 -- - —-—
Xecutng_Instrn[23]

out 0.0000 0.0000 -- - -
Instrn[27] in 0.0000 0.0000 - - -
RESULT_DATA[9] out 0.0000 0.0000 -- — -
Xecutng_Instrn[16]

out 0.0000 0.0000 -- - —-—
Instrn[20] in 0.0000 0.0000 -- - -
RESULT_DATA[2] out 0.0000 0.0000 -- - -
Xecutng_Instrn[9]

out 0.0000 0.0000 -- - —-—
Instrn[13] in 0.0000 0.0000 -- —- -

External Max Min Min Min

Number Wireload Wireload Pin Wire
Port Points Model Model Load Load

Xecutng_Instrn[2]
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Instrn[6]

PSW[61

PSW[9l
Xecutng_Instrn[25]

Instrn[29]
RESULT_DATA[11]

Xecutng_Instrn[18]

Instrn[22]
RESULT_DATA[4]

Xecutng_Instrn[11]

Instrn[15]
Xecutng_Instrn[4]

Instrn[8]
Instrn[1]

PSW[1]
Xecutng_Instrn[27]

Instrn[31]
RESULT_DATA[13]

Xecutng_Instrn[20]

Instrn[24]
RESULT_DATAL6]

Xecutng_Instrn[13]

Instrn[17]
Xecutng_Instrn[6]

Instrn[10]
Instrn[3]

PSW[3]

Reset
Xecutng_Instrn[29]
RESULT_DATA[15]
Xecutng_Instrn[22]

Instrn[26]
RESULT_DATA[8]

Xecutng_Instrn[15]

Instrn[19]
RESULT_DATA[1]

Xecutng_Instrn[8]

Instrn[12]

R R e

RPRRR RpR R

(S

RPRRRER R

=
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Xecutng_Instrn[1]

Instrn[5]

PSW[5]

Clk

PSW[8]
Xecutng_Instrn[31]

Rd_Instr
Xecutng_Instrn[24]

Instrn[28]
RESULT_DATA[10]

Xecutng_Instrn[17]

Instrn[21]
RESULT_DATA[3]

Xecutng_Instrn[10]

Instrn[14]
STACK_FULL
Xecutng_Instrn[3]

Instrn[7]

PSW[7]

PSW[10]

Instrn[O]

PSW[O]
Xecutng_Instrn[26]

Instrn[30]
RESULT_DATA[12]

Xecutng_Instrn[19]

Instrn[23]
RESULT_DATA[5]

Xecutng_Instrn[12]
Instrn[16]
OUT_VALID
Xecutng_Instrn[5]
Instrn[9]
EndOfInstrn
Instrn[2]

PSW[2]
Xecutng_Instrn[28]
RESULT_DATA[14]
Xecutng_Instrn[21]

Instrn[25]

RPRRRR

(S

RPRRPRRRRE RRBR

[

RPRRERRRER RRPR

=
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RESULT_DATA[7]

1 _ _ - _
Xecutng_Instrn[14]

1 —_ —_ —_ —_
Instrn[18] 1 -- -- - -
RESULT_DATA[O]

1 _ _ - _
Xecutng_Instrn[7]

1 —_ —_ —_ —_
Instrn[11] 1 - - - -
Xecutng_Instrn[0]

1 _ _ - _
Instrn[4] 1 -- - - --
PSW[4] 1 -- - - --
Xecutng_Instrn[30]

1 _ _ _ _
Xecutng_Instrn[23]

1 —_ —_ —_ —_
Instrn[27] 1 -- - - --
RESULT_DATA[9]

1 _ _ _ _
Xecutng_Instrn[16]

1 —_ —_ —_ —_
Instrn[20] 1 -- - - --
RESULT_DATA[2]

1 _ _ _ _
Xecutng_Instrn[9]

1 —_ —_ —_ —_
Instrn[13] 1 -- - - --

Input Delay
Min Max Related Max

Input Port Rise Fall Rise Fall Clock Fanout
Instrn[6] 2.00 2.00 2.00 2.00 CIk --
Instrn[29] 2.00 2.00 2.00 2.00 CIk -
Instrn[22] 2.00 2.00 2.00 2.00 CIk -
Instrn[15] 2.00 2.00 2.00 2.00 CIk --
Instrn[8] 2.00 2.00 2.00 2.00 CIk --
Instrn[1] 2.00 2.00 2.00 2.00 CIk --
Instrn[31] 2.00 2.00 2.00 2.00 CIk -
Instrn[24] 2.00 2.00 2.00 2.00 CIk -
Instrn[17] 2.00 2.00 2.00 2.00 CIk --
Instrn[10] 2.00 2.00 2.00 2.00 CIk --
Instrn[3] 2.00 2.00 2.00 2.00 CIk --
Reset 2.00 2.00 2.00 2.00 CIk -
Instrn[26] 2.00 2.00 2.00 2.00 CIk -
Instrn[19] 2.00 2.00 2.00 2.00 CIk --
Instrn[12] 2.00 2.00 2.00 2.00 CIk --
Instrn[5] 2.00 2.00 2.00 2.00 CIk -
Clk -- -- -- -- -- --
Instrn[28] 2.00 2.00 2.00 2.00 CIk -
Instrn[21] 2.00 2.00 2.00 2.00 CIk --
Instrn[14] 2.00 2.00 2.00 2.00 CIk --
Instrn[7] 2.00 2.00 2.00 2.00 CIk -
Instrn[O] 2.00 2.00 2.00 2.00 CIk -

Instrn[30] 2.00 2.00 2.00 2.00 Clk —
Instrn[23] 2.00 2.00 2.00 2.00 CIk —
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Instrn[16]
Instrn[9]

Instrn[2]

Instrn[25]
Instrn[18]
Instrn[11]
Instrn[4]

Instrn[27]
Instrn[20]
Instrn[13]

Input Port

Instrn[6]

Instrn[29]

Instrn[22]

Instrn[15]

Instrn[8]

Instrn[1]

Instrn[31]

Instrn[24]

Instrn[17]

Instrn[10]

Instrn[3]

Reset

Instrn[26]

Instrn[19]

Instrn[12]

NNNNNNNNDNDN

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gFIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gFIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gFIxio/DDRVLS33/Z

.00
.00
.00
.00
.00
.00
.00
.00
.00
.00

.00 CIk
.00 CIk
.00 CIk
.00 CIk
.00 CIk
.00 CIk
.00 CIk
.00 CIk
.00 CIk
.00 CIk

NNNNNNNNDNDN

Q)
gfIxio/DDRVLS33/Z

Q)
gflxio/DDRVLS33/Z

Q)
gFIxio/DDRVLS33/Z

Q)
gflxio/DDRVLS33/Z

Q)
gflxio/DDRVLS33/Z

Q)
gfIxio/DDRVLS33/Z

Q)
gflxio/DDRVLS33/Z

Q)
gFIxio/DDRVLS33/Z

Q)
gflxio/DDRVLS33/Z

Q)
gflxio/DDRVLS33/Z

Q)]
gfIxio/DDRVLS33/Z

Q)
gflxio/DDRVLS33/Z

Q)
gFIxio/DDRVLS33/Z

Q)
gfIxio/DDRVLS33/Z

Q)
gFlIxio/DDRVLS33/Z
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Instrn[5]

Instrn[28]

Instrn[21]

Instrn[14]

Instrn[7]

Instrn[0]

Instrn[30]

Instrn[23]

Instrn[16]

Instrn[9]

Instrn[2]

Instrn[25]

Instrn[18]

Instrn[11]

Instrn[4]

Instrn[27]

Instrn[20]

Instrn[13]

Cell

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gFfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gFIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gFIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

gfIxio/DDRVLS33/Z

Max Drive

Min Drive

Q)
gflxio/DDRVLS33/Z

Q)
gFIxio/DDRVLS33/Z

Q)
gflxio/DDRVLS33/Z

Q)
gflxio/DDRVLS33/Z

Q)
gfIxio/DDRVLS33/Z

Q)
gflxio/DDRVLS33/Z

Q)
gFIxio/DDRVLS33/Z

Q)
gflxio/DDRVLS33/Z

Q)
gflxio/DDRVLS33/Z

Q)
gfIxio/DDRVLS33/Z

Q)
gflxio/DDRVLS33/Z

Q)
gFIxio/DDRVLS33/Z

Q)
gflxio/DDRVLS33/Z

Q)
gflxio/DDRVLS33/Z

Q)]
gfIxio/DDRVLS33/Z

Q)
gflxio/DDRVLS33/Z

Q)
gFIxio/DDRVLS33/Z

Q)
gfIxio/DDRVLS33/Z
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Input Port Rise Fall Rise Fall Max Min Cap Fanout
Deg

Instrn[6] - - - - - - - — -
Instrn[29] - - - - - —— —— - __
Instrn[22] - - — - - —— —-— - __
Instrn[15] - - - — - - - — -
Instrn[8] - - - — - - — — -
Instrn[1] - - - - - - - — -
Instrn[31] - - - - - —— —— - __
Instrn[24] - - — - - —— —-— - __
Instrn[17] - - - — - - - — -
Instrn[10] - - - — - - - — -
Instrn[3] - - - - - - - — -
Reset - - - - - - - - -
Instrn[26] - - — - - —— —-— - __
Instrn[19] - - - — - - - — -
Instrn[12] - - - — - - - — -
Instrn[5] - - - - - - - — -
Clk - - - - - - - - -
Instrn[28] - - — - - —— —-— - __
Instrn[21] - - - — - - - — -
Instrn[14] - - - — - - - — -
Instrn[7] - - - - - - - — -
Instrn[O] - - - - - —— —— - __
Instrn[30] - - — - - —— —-— - __
Instrn[23] - - - — - - - — -
Instrn[16] - - - — - - - — -
Instrn[9] - - - - - - - — -
Instrn[2] - - - - - —— —— - __
Instrn[25] - - — - - —— —-— - __
Instrn[18] - - - — - - - — -
Instrn[11] - - - — - - - — -
Instrn[4] - - - - - - - — -
Instrn[27] - - - - - —— —— - __
Instrn[20] - - — - - —— —-— - __
Instrn[13] - - - — - - - — -
Max Tran Min Tran
Input Port Rise Fall Rise Fall

Instrn[6] - - - -
Instrn[29] - - - -
Instrn[22] - - - -
Instrn[15] - - - -
Instrn[8] - - - -
Instrn[1] - - - -
Instrn[31] - - - -
Instrn[24] - - - _
Instrn[17] - - - -
Instrn[10] - - - -
Instrn[3] - - - -
Reset -— - - -
Instrn[26] - - - -
Instrn[19] - - - -
Instrn[12] - - - -
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Instrn[5] - - - -

Clk - - - --
Instrn[28] - - - -—
Instrn[21] - - - -—
Instrn[14] -- -- -- --
Instrn[7] - - - -
Instrn[0] - - - -
Instrn[30] - - - -—
Instrn[23] - - - -—
Instrn[16] - - - -
Instrn[9] - - - -
Instrn[2] - - - -
Instrn[25] - - - -—
Instrn[18] - - - -—
Instrn[11] -- -- -- --
Instrn[4] - - - -
Instrn[27] - - - -
Instrn[20] - - - -—
Instrn[13] - - - -—
Output Delay
Min Max Related Fanout

Output Port Rise Fall Rise Fall Clock Load
Xecutng_Instrn[2]

0.50 0.50 0.50 0.50 CIk 0.00
PSW[6] 0.50 0.50 0.50 0.50 CIk 0.00
PSW[9] 0.50 0.50 0.50 0.50 CIk 0.00
Xecutng_Instrn[25]

0.50 0.50 0.50 0.50 CIk 0.00
RESULT_DATA[11]

0.50 0.50 0.50 0.50 CIk 0.00
Xecutng_Instrn[18]

0.50 0.50 0.50 0.50 CIk 0.00
RESULT_DATA[4]

0.50 0.50 0.50 0.50 CIk 0.00
Xecutng_Instrn[11]

0.50 0.50 0.50 0.50 CIk 0.00
Xecutng_Instrn[4]

0.50 0.50 0.50 0.50 CIk 0.00
PSW[1] 0.50 0.50 0.50 0.50 CIk 0.00
Xecutng_Instrn[27]

0.50 0.50 0.50 0.50 CIk 0.00
RESULT_DATA[13]

0.50 0.50 0.50 0.50 CIk 0.00
Xecutng_Instrn[20]

0.50 0.50 0.50 0.50 CIk 0.00
RESULT_DATA[6]

0.50 0.50 0.50 0.50 CIk 0.00
Xecutng_Instrn[13]

0.50 0.50 0.50 0.50 CIk 0.00
Xecutng_Instrn[6]

0.50 0.50 0.50 0.50 CIk 0.00
PSW[3] 0.50 0.50 0.50 0.50 CIk 0.00
Xecutng_Instrn[29]

0.50 0.50 0.50 0.50 CIk 0.00

RESULT_DATA[15]
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0.50
Xecutng_Instrn[22]
0.50
RESULT_DATA[8]
0.50
Xecutng_Instrn[15]
0.50
RESULT_DATA[1]
0.50
Xecutng_Instrn[8]
0.50
Xecutng_Instrn[1]
0.50
PSW[5] 0.50
PSW[8] 0.50
Xecutng_Instrn[31]
0.50
Rd_Instr 0.50
Xecutng_Instrn[24]
0.50
RESULT_DATA[10]
0.50
Xecutng_Instrn[17]
0.50
RESULT_DATA[3]
0.50
Xecutng_Instrn[10]
0.50

STACK_FULL 0.50
Xecutng_Instrn[3]

0.50
PSWL71 0.50
PSW[10] 0.50
PSW[O] 0.50
Xecutng_Instrn[26]
0.50
RESULT_DATA[12]
0.50
Xecutng_Instrn[19]
0.50
RESULT_DATA[5]
0.50
Xecutng_Instrn[12]
0.50
OUT_VALID 0.50
Xecutng_Instrn[5]
0.50
EndOfInstrn 0.50
PSWL2] 0.50
Xecutng_Instrn[28]
0.50
RESULT_DATA[14]
0.50
Xecutng_Instrn[21]
0.50
RESULT_DATA[7]
0.50

cNoNoNe) oNe)

o

oo

o [eNeoNe)

.50
.50
-50
.50
.50
.50
.50
.50
-50

.50
.50

-50

.50

.50

-50

.50
.50

-50
.50
.50
.50
.50
.50
-50
.50

.50
-50

.50
.50
-50
-50
.50
-50

-50

cNoNoNe) oNe)

o

oo

o [eNeoNe)

-50
.50
.50
.50
.50
-50
.50
.50
.50

.50
.50

.50

.50

.50

-50

.50
.50

-50
.50
.50
.50
-50
.50
.50
.50

.50
.50

.50
.50
.50
-50
.50
.50

-50

0.50
0.50
0.50
0.50
0.50
0.50
0.50

0.50
0.50

0.50

0.50

.50
.50

oNe)

-50
.50
.50
.50

oNoNoNe)

o

-50

.50
.50

[eNe}

.50
.50
.50

o [eNeoNe)

-50

Clk
Clk
Clk
Clk
Clk
Clk
Clk
Clk
Clk

Clk
Clk

Clk

Clk

Clk

Clk

Clk
Clk

Clk
Clk
Clk
Clk
Clk
Clk
Clk
Clk

Clk
Clk

Clk
Clk
Clk
Clk
Clk
Clk

Clk
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0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00
0.00

0.00
0.00
0.00
0.00
0.00
0.00
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Xecutng_Instrn[14]

0.50 0.50 0.50 0.50 CIk 0.00
RESULT_DATA[O]
0.50 0.50 0.50 0.50 CIk 0.00
Xecutng_Instrn[7]
0.50 0.50 0.50 0.50 CIk 0.00
Xecutng_Instrn[0]
0.50 0.50 0.50 0.50 CIk 0.00
PSW[4] 0.50 0.50 0.50 0.50 CIk 0.00
Xecutng_Instrn[30]
0.50 0.50 0.50 0.50 CIk 0.00
Xecutng_Instrn[23]
0.50 0.50 0.50 0.50 CIk 0.00
RESULT_DATA[9]
0.50 0.50 0.50 0.50 CIk 0.00
Xecutng_Instrn[16]
0.50 0.50 0.50 0.50 CIk 0.00
RESULT_DATA[2]
0.50 0.50 0.50 0.50 CIk 0.00
Xecutng_Instrn[9]
0.50 0.50 0.50 0.50 CIk 0.00
6. Report Cell
AEAEAAAXAXAAAAAAXAAAXAAAAXAAAXAAAAAAAXAAAXAAAAXAAK
Report : cell
-connections
-verbose

Design : RISC_CORE
Version: 2003.06

Date - Mon Sep 13 13:39:59 2004
R AR R R e S o S R e R e R e R R S L R L S
Connections for cell "1 _STACK TOP/12_STACK MEM":
Reference: STACK_MEM 1
Hierarchical: TRUE
Area: 1952.87
dont_touch: FALSE
Input Pins Net Net Driver Pins Driver Pin Type
Clk I_STACK TOP/Clk
Clk Input Port
PushEnbl I_STACK_TOP/PushEnbl
I_CONTROL/U129/Z Output Pin
(BUFM10P)
PopEnbl I_STACK _TOP/PopEnbl
I_CONTROL/U132/Z Output Pin
(AND2M4P)
Stack_Full I_STACK_TOP/STACK_FULL

I_STACK_TOP/1_STACK_FSM/STACK_FULL_reg/Q
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(FD1LQM3P)

TOS[0]

I_STACK_TOP/TOS[O]

I_STACK_TOP/1_STACK_FSM/TOS_int_reg[0]/Q

(FD1QM3P)

TOS[1]

I_STACK_TOP/TOS[1]

I_STACK_TOP/1_STACK_FSM/TOS_int_reg[1]/Q

(FD1QM3P)

TOS[2]

I_STACK_TOP/TOS[2]

I_STACK_TOP/1_STACK_FSM/TOS_int_reg[2]/Q

(FD1QM3P)

PushDataln[3]

I_STACK_TOP/PushDataln[7]

I_PRGRM_CNT_TOP/1_PRGRM_CNT/PCint_reg[7]/Q

(FD1LQM1P)

PushDataln[2]

I_STACK_TOP/PushDataln[6]

I_PRGRM_CNT_TOP/1_PRGRM_CNT/PCint_reg[6]/Q

(FD1LQM1P)

PushDataln[1]

I_STACK_TOP/PushDataln[5]

I_PRGRM_CNT_TOP/1_PRGRM_CNT/PCint_reg[5]/Q

(FD1LQM1P)

PushDataln[O]

I_STACK_TOP/PushDataln[4]

I_PRGRM_CNT_TOP/1_PRGRM_CNT/PCint_reg[4]/Q

(FD1LQM1P)

Output Pins

PopDataOut[3]

Net Net Load Pins

I_STACK_TOP/PopDataOut[7]

I_PRGRM_CNT_TOP/1_PRGRM_CNT/U50/B

(A0222M2P)

PopDataOut[2]

I_STACK TOP/PopDatalut[6]

I_PRGRM_CNT_TOP/1_PRGRM_CNT/U49/A
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Input Pin

(A0222M2P)
PopDataOut[1] I_STACK _TOP/PopDataOut[5]
I_PRGRM_CNT_TOP/1_PRGRM_CNT/U48/A
Input Pin
(A0222M2P)
PopDataOut[O0] I_STACK TOP/PopDatalOut[4]
I_PRGRM_CNT_TOP/1_PRGRM_CNT/U47/A
Input Pin

(A0222M2P)

7. Report Net

SRR R S kR o SR S S R S R R SR R AR SR R R S SR R SR SRR SR SR S

Report : net
-min
-connections
-verbose
Design - RISC_CORE
Version: 2003.06
Date - Mon Sep 13 13:41:28 2004
R e e R e e R R R e e S e e
net "Oprnd_A[11]":
dont_touch: FALSE
pin capacitance: 0.0227
wire capacitance: 0.0323145
total capacitance: 0.0550145

wire resistance: 0.110102
number of drivers: 1
number of loads: 4
number of pins: 5

Connections for net "Oprnd_A[11]":

Driver Pins Type Pin Cap

1_DATA PATH/Oprnd_A reg[11]/0Q
Output Pin (FD1SLQM3P)
0

Load Pins Type Pin Cap

I_ALU/r355_11/U44/A Input Pin (NIM1P)  0.0054
I_ALU/r355_11/U27/B Input Pin (ND2BNM1P)

0.0032
1_ALU/U349/A Input Pin (AO22M1P) 0.0035
1_ALU/U397/S Input Pin (MUX21HFM2P)
0.0106
net "Oprnd_A[4]":
dont_touch: FALSE
pin capacitance: 0.0184

wire capacitance: 0.0323145
total capacitance: 0.0507145
wire resistance: 0.110102
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number of drivers:
number of loads:
number of pins:

1
4
5

Connections for net "Oprnd_A[4]":

net

Driver Pins

1_DATA_PATH/Oprnd_A_reg[4]1/Q

Load Pins
1 _ALU/r355 11/U51/A
1 _ALU/r355 11/U23/B

1_ALU/U356/A
1_ALU/U248/S

"Oprnd_A[13]":
dont_touch:

pin capacitance:
wire capacitance:
total capacitance:
wire resistance:
number of drivers:
number of loads:
number of pins:

Output Pin (FD1SLQM1P)

Input Pin (N1IM1P) 0.0054
Input Pin (ND2BNM1P)
0.0032
Input Pin (AO22M1P) 0.0035
Input Pin (MUX21HM1P)
0.0063

FALSE
0.029
0.0323145
0.0613145
0.110102
1

4

5

Connections for net "Oprnd_A[13]":

net

Driver Pins

1_DATA PATH/Oprnd_A reg[13]/Q

Load Pins

Output Pin (FD1SLQM3P)

I_ALU/r355_11/U136/B

Input Pin (ND2BNM2P)
0.0043

I_ALU/r355_11/U100/A

1_ALU/ZU347/A
1_ALU/U393/S

"Oprnd_A[6]":
dont_touch:

pin capacitance:
wire capacitance:
total capacitance:
wire resistance:
number of drivers:
number of loads:
number of pins:

Input Pin (N1M2P) 0.0106

Input Pin (AO22M1P) 0.0035

Input Pin (MUX21HFM2P)
0.0106

FALSE
0.0184
0.0323145
0.0507145
0.110102
1

4

5

Connections for net "Oprnd_A[6]":

Driver Pins
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I_DATA PATH/Oprnd_A reg[6]/Q
Output Pin (FD1SLQM1P)
0

Load Pins Type Pin Cap

I_ALU/r355_11/U74/A Input Pin (NIM1P)  0.0054
I_ALU/r355_11/U16/B Input Pin (ND2BNM1P)

0.0032
1_ALU/U354/A Input Pin (A022M1P) 0.0035
1_ALU/U234/S Input Pin (MUX21HM1P)
0.0063
net "Oprnd_A[15]":
dont_touch: FALSE
pin capacitance: 0.0237
wire capacitance: 0.0229291
total capacitance: 0.0466291
wire resistance: 0.0781237
number of drivers: 1
number of loads: 3
number of pins: 4
Connections for net "Oprnd_A[15]":
Driver Pins Type Pin Cap

net

1_DATA PATH/Oprnd_A reg[15]/Q
Output Pin (FD1SLQM3P)

Load Pins Type Pin Cap

1_ALU/r355_11/U103/A
Input Pin (EOFM2P) 0.0096

1_ALU/U345/A Input Pin (A022M1P) 0.0035

1_ALU/U381/S Input Pin (MUX21HFM2P)
0.0106

"Oprnd_A[8]":

dont_touch: FALSE

pin capacitance: 0.0184

wire capacitance: 0.0323145
total capacitance: 0.0507145

wire resistance: 0.110102
number of drivers: 1
number of loads: 4
number of pins: 5

Connections for net "Oprnd_A[8]":

Driver Pins Type Pin Cap

I_DATA_PATH/Oprnd_A_reg[8]/Q
Output Pin (FD1SLQM1P)

Load Pins Type Pin Cap

I_ALU/r355_11/U71/A Input Pin (NIM1P)  0.0054
I_ALU/r355_11/U22/B Input Pin (ND2BNM1P)

0.0032
I_ALU/U352/A Input Pin (A022M1P) 0.0035
I_ALU/U241/S Input Pin (MUX21HM1P)
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0.0063
net "Oprnd_A[1]":
dont_touch: FALSE
pin capacitance: 0.0184
wire capacitance: 0.0323145
total capacitance: 0.0507145

wire resistance: 0.110102
number of drivers: 1
number of loads: 4
number of pins: 5

Connections for net "Oprnd_A[1]":

Driver Pins Type Pin Cap

I_DATA_PATH/Oprnd_A_reg[1]/Q
Output Pin (FD1SLQM3P)

0
Load Pins Type Pin Cap
1_ALU/r355 11/U60/B Input Pin (ND2BNM1P)
0.0032
I_ALU/r355_11/U63/A Input Pin (N1M1P) 0.0054
1_ALU/U359/A Input Pin (A022M1P) 0.0035
1_ALU/U311/S Input Pin (MUX21HM1P)
0.0063
net "Oprnd_A[10]":
dont_touch: FALSE
pin capacitance: 0.0227
wire capacitance: 0.0323145
total capacitance: 0.0550145
wire resistance: 0.110102
number of drivers: 1
number of loads: 4
number of pins: 5
Connections for net "Oprnd_A[10]":
Driver Pins Type Pin Cap

I_DATA_PATH/Oprnd_A_reg[10]/Q
Output Pin (FD1SLQM3P)
0

Load Pins Type Pin Cap
I_ALU/r355 11/U34/B Input Pin (ND2BNM1P)
0.0032
I_ALU/r355_11/U367A Input Pin (N1M1P) 0.0054
1_ALU/U350/A Input Pin (A022M1P) 0.0035
1_ALU/U398/S Input Pin (MUX21HFM2P)
0.0106
net "Oprnd_A[3]":
dont_touch: FALSE
pin capacitance: 0.0184

wire capacitance: 0.0323145
total capacitance: 0.0507145

wire resistance: 0.110102
number of drivers: 1
number of loads: 4
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number of pins: 5
Connections for net "Oprnd_A[3]":

Driver Pins Type Pin Cap

I_DATA PATH/Oprnd_A reg[3]/Q
Output Pin (FD1SLQM1P)
0

Load Pins Type Pin Cap
I_ALU/r355_11/U65/B Input Pin (ND2BNM1P)
0.0032
I_ALU/r355 11/U67/A Input Pin (N1M1P) 0.0054
1_ALU/U357/A Input Pin (A022M1P) 0.0035
1_ALU/U274/S Input Pin (MUX21HM1P)
0.0063
net "Oprnd_A[12]":
dont_touch: FALSE
pin capacitance: 0.0227
wire capacitance: 0.0323145
total capacitance: 0.0550145
wire resistance: 0.110102
number of drivers: 1
number of loads: 4
number of pins: 5
Connections for net "Oprnd_A[12]":
Driver Pins Type Pin Cap

I_DATA_PATH/Oprnd_A_reg[12]/Q
Output Pin (FD1SLQM1P)

Load Pins Type Pin Cap

I_ALU/r355_11/U75/A Input Pin (NIM1P)  0.0054
I_ALU/r355_11/U42/B Input Pin (ND2BNM1P)

0.0032
1_ALU/U348/A Input Pin (A022M1P) 0.0035
1_ALU/U396/S Input Pin (MUX21HFM2P)
0.0106
net "Oprnd_A[5]":
dont_touch: FALSE
pin capacitance: 0.0184
wire capacitance: 0.0323145
total capacitance: 0.0507145
wire resistance: 0.110102
number of drivers: 1
number of loads: 4
number of pins: 5
Connections for net "Oprnd_A[5]":
Driver Pins Type Pin Cap

I_DATA_PATH/Oprnd_A_reg[5]/Q
Output Pin (FD1SLQM1P)
0

Load Pins Type Pin Cap
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I_ALU/r355_11/U76/A Input Pin (NIM1P)  0.0054
I_ALU/r355_11/U14/B Input Pin (ND2BNM1P)

0.0032
1_ALU/U355/A Input Pin (A022M1P) 0.0035
1_ALU/U281/S Input Pin (MUX21HM1P)
0.0063
net "Oprnd_A[14]":
dont_touch: FALSE
pin capacitance: 0.0238
wire capacitance: 0.0323145
total capacitance: 0.0561145
wire resistance: 0.110102
number of drivers: 1
number of loads: 4
number of pins: 5
Connections for net "Oprnd_A[14]":
Driver Pins Type Pin Cap

I_DATA PATH/Oprnd_A reg[14]/Q
Output Pin (FD1SLQM1P)
0

Load Pins Type Pin Cap
I_ALU/r355_11/U73/A Input Pin (N1M1P) 0.0054
I_ALU/r355_11/U140/B

Input Pin (ND2BNM2P)

0.0043
1_ALU/U346/A Input Pin (A022M1P) 0.0035
1_ALU/U388/S Input Pin (MUX21HFM2P)
0.0106
net “Oprnd_A[7]":
dont_touch: FALSE
pin capacitance: 0.0184
wire capacitance: 0.0323145
total capacitance: 0.0507145
wire resistance: 0.110102
number of drivers: 1
number of loads: 4
number of pins: 5
Connections for net "Oprnd A[7]":
Driver Pins Type Pin Cap

I_DATA_PATH/Oprnd_A_reg[7]1/Q
Output Pin (FD1SLQM1P)
0

Load Pins Type Pin Cap

I_ALU/r355_11/U72/A Input Pin (NIM1P)  0.0054
I_ALU/r355_11/U19/B Input Pin (ND2BNM1P)

0.0032
I_ALU/U353/A Input Pin (A022M1P) 0.0035
I_ALU/U245/S Input Pin (MUX21HM1P)

0.0063

net "Oprnd_A[O0]":
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dont_touch:

pin capacitance:
wire capacitance:
total capacitance:
wire resistance:
number of drivers:
number of loads:
number of pins:

FALSE
0.0152
0.0229291
0.0381291
0.0781237
1

3

4

Connections for net "Oprnd_A[0]":

net

Driver Pins

I_DATA_PATH/Oprnd_A_

Load Pins
1_ALU/r355 11/U29/A
1_ALU/U360/A
1_ALU/U309/S

"Oprnd_A[9]":
dont_touch:

pin capacitance:
wire capacitance:
total capacitance:
wire resistance:
number of drivers:
number of loads:
number of pins:

reg[0]/Q

Output Pin (FD1SLQM1P)
0

Input Pin (NIM1P)  0.0054
Input Pin (A022M1P) 0.0035
Input Pin (MUX21HM1P)

FALSE
0.0184
0.0323145
0.0507145
0.110102
1

4

5

Connections for net "Oprnd_A[9]":

net

Driver Pins

1_DATA PATH/Oprnd_A reg[9]/Q
Output Pin (FD1SLQM1P)
0

Load Pins
I_ALU/r355 11/U53/A
1_ALU/r355 11/U38/B

1_ALU/U351/A
I_ALU/U257/S

"Oprnd_A[2]":
dont_touch:

pin capacitance:
wire capacitance:
total capacitance:
wire resistance:
number of drivers:
number of loads:
number of pins:

Input Pin
Input Pin

Input Pin
Input Pin

FALSE
0.0195
0.0323145
0.0518145
0.110102
1

4

5

Connections for net "Oprnd_A[2]":

Driver Pins

Type

0.0063

Pin Cap
(NIM1P) 0.0054
(ND2BNM1P)

0.0032
(A022M1P) 0.0035
(MUX21HM1P)

0.0063

Pin Cap
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1_DATA PATH/Oprnd_A reg[2]/Q
Output Pin (FD1SLQM3P)
0

Load Pins Type Pin Cap

I_ALU/r355_11/U110/B
Input Pin (ND2BNM2P)

0.0043
1_ALU/r355 11/U58/A Input Pin (N1M1P) 0.0054
1_ALU/U358/A Input Pin (A022M1P) 0.0035
1_ALU/U314/S Input Pin (MUX21HM1P)
0.0063
8. Report Clock
KEEEAAAAAXIXIAIEAAAAAAAXIXAAAAAAAARAAAXAAAXAAAARNLK
Report : clocks
Design : RISC_CORE
Version: 2003.06
Date - Mon Sep 13 13:42:39 2004
KEEEAAAAAXIAIAITEAAAAAAAXITXAAAAAAAAAAAAAAXAAAAA,K
Attributes:
d - dont_touch_network
f - fix_hold
p - propagated_clock
G - generated_clock
Clock Period Waveform Attrs Sources
Clk 4.00 {0 2} {CIk}

9. Report Area

R R R R e R R R R AR AR R AR AR R AR AR AR AR R R R R R R AR R AR

Report : area

Design : RISC_CORE

Version: 2003.06

Date : Mon Sep 13 13:43:16 2004

R R e R R R R R R AR R AR AR R AR AR AR AR R R R R R R R R

Library(s) Used:

gflxp (File:
/usr/apps/eda/flexstream.3.3/1si_fs_3.3/1i1b3p/synopsys/gfixp/gflxp Isi_

wc.db)

Number of ports: 97
Number of nets: 278
Number of cells: 41
Number of references: 9
Combinational area: 9271.859375
Noncombinational area: 9372.499023
Net Interconnect area: 8347 .217773
Total cell area: 18644 .380859
Total area: 26991.578125
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10. Report Compile Options

R R e e R e R R R e e R e R e R R R e R e e e R e R e e e e
Report : compile_options

Design : RISC_CORE

Version: 2003.06

Date : Mon Sep 13 13:44:51 2004

R R e o e R e R R R e R e R e R R e R e e e e e R e R e e

Design Compile Option Value

RISC_CORE flatten false
structure true
structure_boolean false
structure_timing true
isolate port

disabled

ALU flatten false
structure true
structure_boolean false
structure_timing true

ALU_DWO1_addsub_16_ 2 flatten false
structure true
structure_boolean false
structure_timing true

ALU DWO1 addsub 16 O flatten false
structure true
structure_boolean false
structure_timing true

CONTROL flatten false
structure true
structure_boolean false
structure_timing true

DATA PATH flatten false
structure true
structure_boolean false
structure_timing true

INSTRN_LAT flatten false
structure true
structure_boolean false
structure_timing true

PRGRM_CNT_TOP flatten false
structure true
structure_boolean false
structure_timing true

PRGRM_FSM flatten false
structure true
structure_boolean false
structure_timing true

PRGRM_DECODE flatten false
structure true
structure_boolean false
structure_timing true

PRGRM_CNT flatten false
structure true
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PRGRM_CNT_DWO1_inc_8_0

REG_FILE

STACK_TOP

STACK_FSM

STACK_MEM_2

STACK_MEM_1

STACK_MEM_O

11. Report Power

FAEIIAAXAIAAAXAAAXAAAAXAAAAAAALAAAAAAAAAAAhAihix

Report : power
-analysis_effort low
-verbose

Design : RISC_CORE

Version: 2003.06

Date - Mon Sep 13 13:46:15 2004

R R R e R R R R R R AR R AR AR R AR AR AR R R AR R R R R R R

Library(s) Used:

gflxp (File:

/usr/apps/eda/flexstream.3.3/1si_fs_3.3/1i1b3p/synopsys/gfixp/gflxp Isi_

wc.db)
Operating Conditions: LSI_WC
Wire Load Model Mode: enclosed

Wire Load Model

structure_boolean
structure_timing
flatten

structure
structure_boolean
structure_timing
flatten

structure
structure_boolean
structure_timing
flatten

structure
structure_boolean
structure_timing
flatten

structure
structure_boolean
structure_timing
flatten

structure
structure_boolean
structure_timing
flatten

structure
structure_boolean
structure_timing
flatten

structure
structure_boolean
structure_timing

Library: gflxp

Library
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RISC_CORE B1X1 gflxp

ALU BO.2X0.2 gflxp
ALU_DWO1_addsub_16_2 B0.1X0.1 gflxp
ALU_DWO1_addsub_16_0 B0.1X0.1 gflxp
CONTROL BO.1X0.1 gflxp
DATA_PATH BO.1X0.1 gflxp
INSTRN_LAT BO.1X0.1 gflxp
PRGRM_CNT_TOP BO.1X0.1 gflxp
PRGRM_FSM BO.1X0.1 gflxp
PRGRM_DECODE BO.1X0.1 gflxp
PRGRM_CNT BO.1X0.1 gflxp
PRGRM_CNT_DWO1_inc_8 0 BO.1X0.1 gflxp
REG_FILE BO.2X0.2 gflxp
STACK_TOP BO.2X0.2 gflxp
STACK_FSM BO.1X0.1 gflxp
STACK_MEM_2 BO.1X0.1 gflxp
STACK_MEM_1 BO.1X0.1 gflxp
STACK_MEM_O BO.1X0.1 gflxp

Global Operating Voltage = 1.08
Power-specific unit information :
Voltage Units = 1V
Capacitance Units = 1.000000pf
Time Units = 1ns
Dynamic Power Units = 1mW (derived from V,C,T units)
Leakage Power Units = Unitless
Cell Internal Power Breakdown

Combinational 329.1682 uw (4%)
Sequential 5.4080 mw (73%)
Other 0.0000 mw (0%)

Combinational Count 1298
Sequential Count 310
Other Count 0

Cell Internal Power
Net Switching Power

5.7371. mW  (77%)

1.7060 mW  (23%)
Total Dynamic Power 7.4432 mW  (100%)
Cell Leakage Power -

I
o
o
o
o
o
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